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ARDUINO COMPUTER NUMERICAL CONTROL DRAWING MACHINE 

 

 

ABSTRACT 

 

 

Computer Numerical Control, CNC machine is one of the most common machines 

that widely used in the industries nowadays. Many works that involve in movement 

or action that keep repeating everyday were substituted by the CNC machine from 

human as the human concentration becomes lower when times goes on while the 

product quality and quantity fabricated by machine will be maintain when times 

move. However, the cost of CNC machine use in industries is very high which 

causes the machine is not affordable in the small businesses and family use. This 

project is works to design a low cost Arduino based CNC machine that can perform 

drawing according to the given scale set by the user. The low price CNC machine is 

build for the small business company and family use. In this project, some types of 

CNC machine have been reviewed and discussed. The methodology of the hardware 

build, the required software and the operation flow of the machine have discussed in 

this project. The designs of the 3D printed components for the CNC drawing 

machine have been show in the result. Two types of images which are the input 

image and the import image have been tested. The scale of the original image and the 

drawn image have been compared and discussed. Two users have been invited to 

review on the CNC drawing machine. Future enhancements and recommendation 

such as the software development and the additional axis add to perform three 

dimensional printing have been discussed on this project.  
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CHAPTER 1 

 

 

 

INTRODUCTION 

 

 

 

1.1 Background 

  

The technology in the world has been speed up in this century. Works that involve 

movement or action keep repeating all the time has been substitute by machine from 

human as human concentration become lower when time goes on. For the machine, 

the performance in accuracy and precision can maintain when the time moves on. 

Computer Numerical Control, CNC machine is a machine that been widely used in 

the industry nowadays.  

  

There are many types of CNC machine being used in the industry such as 

CNC milling machine, CNC routers, circuit drawing and the others. CNC milling 

machine is a machine that automatically cut the provided material by follow the 

instructions given by the computer. For the CNC routers, it is used to make cuts, as 

well as computer programmable 3D printing and also turret punch purpose. The CNC 

machine can be used in different cutter including laser, water and plasma as well. G-

code is the code use to program the CNC machine. The instruction or drawing input 

by the user will convert into G-code and transfer to the machine to carry out the 

given task. G-code is a low level language which can only be understands by the 

machine. CNC machine plays an important role to fabricate the part of product 

quickly and accurately. With the CNC machine, the industries can speed up their 

production quality and also quantity.  
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1.2 Project Statements 

 

Generally, CNC machine had been widely used in the industries. With the invention 

of CNC machine, many work can be replace by the machine instead of using men 

power. CNC machine boosts the productivity of the industries as well as the accuracy. 

However, the cost of a CNC machine used in industry is very high which is not 

affordable for small businesses and family use. Besides, CNC machine used in the 

industries nowadays only have a single function. In this project, a simple low cost 

Arduino based CNC machine had been built to perform simple drawing in X-axis 

and Y-axis according to the given image scale. This low cost CNC machine is built 

for the family use and small businesses as the price is cheaper compared to the 

industries CNC machine. This project is constructed to study the working principle 

of the machine and to learn on the hardware and software used for the machine. 

  

  

  

1.3 Project Objective 

  

The objectives of this project are shown below: 

i. To build a low cost Arduino based CNC machine for small businesses and 

family use. 

ii. To build CNC machine hardware which able to communicate with software. 

iii. To run the CNC machine in both X-axis and Y-axis for simple drawing.  

iv. To transfer gcode file from software to hardware to perform simple drawing.  

v. To perform simple drawing according to the given scale. 
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1.4 Project Scope 

  

The project consists of the CNC machine hardware designing, hardware building, 

calibration of the stepper motor for synchronise drawing and the communication 

between the hardware and software. Some of the addition features are added in the 

project such as additional function like limit switch homing function was added on 

the CNC machine. The project has been complete by April 2019 with some 

improvement to make the project more attractive and user friendly. 

  

  

 

1.5 Summary of Entire Project 

  

This project consists of five chapters for the body test. The first chapter of the project 

discuss about the introductory of the entire project and some background study of the 

CNC machine. In this chapter, it also mentions about problems faced and how these 

problems been solved as well as the project statements, objectives and project scopes. 

  

 Next, the research works of the project are elaborated in the second chapter of 

the body text. In this chapter, the history of CNC machine was briefly discussed. The 

types of CNC machine, functionality as well as the 2-axis and 3-axis CNC machine 

are discussed in this chapter. Some projects built with different based CNC machine 

also have review in this chapter. 

  

For the following chapter, which is chapter three, the methodology, project 

flow and operating process of this project have been discussed. The selection of the 

materials and software used to run the CNC machine are shown in this chapter. The 

equipment and cost analysis and the project milestone are shown in the last section in 

this chapter as well. 

  

The drawing results of the CNC machine built are compared with the original 

image and discussed in chapter four. Some hardware components design will be 

shown and discussed in this chapter. The problems that encountered in the project as 

well as the solutions for the problems have been discussed in the last section of this 
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chapter. Finally, the chapter five is the last chapter for this project. This chapter 

concludes overall project and the future improvements of this project have listed on 

this chapter. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

 

CHAPTER 2 

 

 

 

LITERATURE REVIEW 

 

 

 

2.1 Background Study 

 

Automation is defined as work done with the control system such as the computer 

numerical control. The birth of CNC was given in America in year of 1959 (Dey, 

Mondal, Barik, 2016). CNC machines then lead the industries toward an evolution. 

CNC machine is a machine that controlled by computer with input command data, 

code numbers, letters or symbols. CNC machine had been widely used as the 

automation control in industrial. By operating product using the CNC machine, the 

precision of product made can be guaranteed up to 1/1000 mm (microns) 

workmanship mass product (Sutarman, EdiHermawan, Sarmidi, 2017). Thus, the 

need of human intervention can be reduced as the mechanization can assists 

operators in the muscular requirement of work as well as decrease the involvement 

for human mental and sensory requirement (Modi, Prof. Patel, 2015). CNC machine 

can work semi-automatically or fully automatic according to the programme set by 

user. Many research studies are done to lower the cost of the CNC machine and 

trying to apply the CNC machine in different work areas.  

  

  

 

 2.2 Types of CNC machine 

 

In this section, different types of CNC machines have been review for study purpose. 
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2.2.1 CNC Pick and Place Machine 

 

CNC pick and place machine is machine which picks up the objects and places the 

object on the present destination. According to the researchers, CNC pick and place 

machine can reduce time development required for trial and error process, boost 

productivity and reduce men-power requirement (Modi, Prof. Patel, 2015).  

 

  

Figure 2.1: Linear CNC Pick and Place Machine 

  

 

The pick and place machine can be classified into major two types of 

machine which are the linear pick and place machine and rotation pick and place 

machine. Linear pick and place machine pick the object vertically or horizontally 

while for the rotation pick and place machine pick and place the object by rotating at 

the stationary point instead of moving along the horizontal axis and vertical axis. 

 

 

 

2.2.2 CNC Laser Cutting Machine 

 

  

Figure 2.2: CNC Laser Cutting Machine 



7 

CNC laser cutting machine is a machine that normally use CO2 and Nd:YAG to cut 

materials by focusing the laser beam direct on the material surface that want to cut. 

There are few methods of cutting such as the vaporization cutting (focus beam heat 

on the material surface to create hole), melt and blow (use gas jet to blow the molten 

material away) and reactive cutting which is use to cut thick carbon steel with little 

laser power. CNC Nd:YAG laser robot able to cutting and soldering sheet metal 

components made of steel, stainless steel and aluminium (Radovanovic, 2002). 

 

 Figure 2.3: CNC Laser Cutting Machine Working Principle 

  

 

Besides using laser for cutting purpose, laser beam also can be used for 

welding purpose. Laser welding is a process that joining the two metals together by 

applying brazing material and shoot the material using laser beams. Once the brazing 

material solidified, both metals will join together. 
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2.2.3 CNC Milling Machine 

 

  

Figure 2.4: CNC Milling Machine 

 

  

CNC milling machine is a machine that uses rotary cutters to remove or reshape 

material such as the wood or metal from surface of the work piece. The starting point 

of the CNC milling machine was using the placement of cutting tool as the reference 

while the milling part of the machine, the two side junction of the work piece are 

used as the reference point (Sutarman, EdiHermawan and Sarmidi, 2017).  

 

  

Figure 2.5: Working Principle of Milling Process 

 

 

For the milling process, the rotary cutter rotates on its spindle and the work 

piece will move toward for milling where the milling process depends on the user 

input data. 
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2.2.4 CNC 3D Printer 

 

CNC 3D printer is an evolution from the 2D printer. 3D printer can print out a 3 

dimensional object after receive the G-code from the computer. The material use for 

printing is the thermoplastics, which is a plastic that will become semi-liquid above 

the specific heat and will return to solid again when cool down. 

 

  

Figure 2.6: CNC 3D Printer 

  

 

According to Nematollahi, Ming and Sanjayan (2017), architecture using the 

3D printer concept to construct a house by created a largest 3D printer in world that 

uses sand and chemical binding agent to create stone-like material. With this 

construction method, it successfully reduces the construction time compared to old 

construction method. It also helps in saving cost as well as reducing men power in 

construction.  

 

  

Figure 2.7: CNC 3D Print House 
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2.3 Hardware System Overview 

 

This section will give the overview on the hardware that been used for this project. 

 

 

 

2.3.1  Arduino Uno Microcontroller 

 

  

Figure 2.8: Arduino Uno Microcontroller 

  

Arduino Uno is a microcontroller that provides easy way for student or professional 

to create own devices in cheaper way. Arduino is an open source microcontroller that 

runs under C and C++ language programme. The coding written to Arduino board 

can be overwritten any time when you wish to do another project. With help of CNC 

Shield V3, it will be able to control the stepper motor in the easiest way. Shivakumar 

and Selvajyothi (2016) used the Arduino Uno board as a signal generator to direct 

importing the CAD file into system without compromising on the performance of the 

system. 

  

 

 

2.3.2 CNC Shield V3 

 

 

Figure 2.9: CNC Shield V3 
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CNC Shield basically is a stepper motor driver board that receives signal from 

Arduino Uno microcontroller and requires external power source to deliver to the 

stepper motors (Dey, Mondal, Barik, 2016). CNC Shield is a shield that helps to set 

up CNC machine in easier way. With the CNC Shield V3, it able to control up to 4 

stepper motors by using the A4988 motor driver. With this shield and Arduino Uno 

microcontroller, the CNC machine such as pick and place machine, CNC router, 

engraving machine and also 3D printer project can be done.  

 

 

 

2.3.3 Motor Driver 

 

  

Figure 2.10: A4988 Stepper Motor Driver 

  

 

The A4988 is a micro-stepping motor driver with built-in translator which allows 

easy implementation of A4988. This driver designs to operate the bipolar stepper 

motor in full, quarter, eighth and sixteenth step mode. 

 

 

Figure 2.11: L293D Motor Driver 

 

 

Rupanagudi, et al. (2015) uses the L293D motor driver to driver the DC 

motor to move along the axis in his project. 
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2.3.4 Motor  

 

  

Figure 2.12: Nema 17 Stepper Motor 

  

 

Nema 17 Stepper motor is a four phase, unipolar, permanent magnet stepper motor. 

It consists of 200-steps-per-revolution. Each step of the stepper motor turns the shaft 

in 1.8 degree for full step and 0.9 degree for half step. The CNC shield V3 and 

A4988 motor drivers have been used in the project to drive the stepper motor.  

 

 

Figure 2.13: DC Motor 

  

 

 Rupanagudi, et al. (2015) using a DC motor for the CNC drawing project 

instead of using the stepper motor. Stepper motor has been chosen to use in this 

project as it will not overload easily compare to the DC motor. 
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2.4 Universal Gcode Sender Software 

 

Universal Gcode sender software is software that receives the imported gcode file 

and sends instructions to the machine to perform drawing.  The Gcode sender 

software is open source software that can be used as an interface for the CNC 

controller like the GRBL and TinyG. 

 

  

Figure 2.14: Universal Gcode Sender Software 

 

 

 Besides of using the gcode file for drawing the image, Rupanagudi, et al. 

(2015) using an image processing method through Matlab to perform simple drawing. 

 

 

Figure 2.15: CNC Drawing Machine with Image Processing Method 

(Rupanagudi, et al., 2015) 

 



 

 

 

CHAPTER 3 

 

 

 

METHODOLOGY 

 

 

 

3.1 Introduction 

 

This chapter illustrates the software use for the CNC machine, the idea and the 

component used in the hardware system design of the CNC machine. The process 

and system flow of the machine are mentioned in this chapter to give a clear 

illustration on the system design.  

  

  

  

3.2 Project Flow 

   

 

Figure 3.1: Project Flow for Arduino CNC Drawing Machine 



15 

3.3        Material Selection 

  

This subsection will talked about the basic functionality of materials and component 

used in the CNC machine. 

  

  

  

3.3.1     Motor Selection 

  

Stepper motor in CNC machine functions as the rail for the machinery part to move 

along the X-axis and also the Y-axis. A Nema 17 Stepper motor has 200 steps-per-

revolution which only steps the shaft for 1.8 degree per step. The Stepper motors 

were choose to build the CNC machine as the stepper motor is cheaper in price and 

the handling torque for the stepper motor is high to carry heavy load. 

  

Technical Details: 

 200 steps pre revolution, 1.8 degree 

 Bipolar stepper 

 4 wire, 8 inch leads 

 5 mm diameter drive shaft with a machine flat 

 12 V rated voltage at 1 – 1.5 A 

  

  

Figure 3.2: Dimension of Nema 17 Stepper Motor 
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3.3.2    Arduino Uno Microcontroller 

  

Arduino Uno is a microcontroller board base on ATmega328. It has 14 digital I/O 

pins and 6 analog input pins. Out of the 14 pin, 6 I/O pins can be used as PWM 

outputs. Arduino Uno is an advanced microcontroller that used as the learning kit for 

building devices Arduino Uno microcontroller supports the C and C++ programming 

language which has been learn during last few year. . It is easy to upload a program 

inside the microcontroller compare to the traditional microcontroller. With Arduino, 

user can directly write the coding inside it with just a laptop that done Arduino 

software installation and an USB cable. The Arduino also can be rewrite at the 

instant time by directly upload a new coding in the microcontroller.  

 

  

Figure 3.3: Arduino Uno Microcontroller 

  

  

  

3.3.3    CNC Shield V3 

  

CNC shield V3 was used in the project as it is compatible to the Arduino Uno. This 

shield allows the Arduino to drive up to four stepper motors. By using the CNC 

shield, it allows everyone to construct the CNC machine in more convenient way and 

to reduce the time spent in building process. This CNC shield requires extra power 

supply as it requires 12 V to power up the shield. 
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Figure 3.4: CNC Shield V3 

  

  

  

3.3.4    A4988 Stepper Motor Driver 

 

A4988 stepper motor driver has been selected to use in the project as it is compatible 

with the CNC shield V3. The driver of motor is cheaper and easily to use as it just 

need to plug on the CNC shield V3 slots. For this project, 2 A4988 are required to 

drive the x-axis and y-axis stepper motor. Heat sink was attached on the motor driver 

to absorb heat generated by the motor driver, thereby allowing regulation of the 

device’s temperature at the optimal level. 

  

  

Figure 3.5: A4988 Stepper Motor Driver with Heat Sink 
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3.3.5    2020 Model Aluminium  

  

The 2020 model aluminium was selected as the body of the machine. The machine 

body that built using aluminium is light enough to allow user to carry the machine 

along with them easily. 

  

  

Figure 3.6: 2020 Model Aluminium 

  

  

  

3.3.6    PLA Filament 

  

PLA filament also known as the Polylactic Acid filament, which is the natural raw 

material used in 3D printing. Some components of CNC machine were printed by 3D 

printer using PLA filament to reduce the costs of the project. 

  

  

Figure 3.7: PLA Filament 
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3.3.7       12 V 20 A Power Supply 

  

A 12V 20A power supply has been used in this project as a power source to supply 

power to the x-axis and y-axis stepper motor. This power supply able to converts AC 

110V/ 220V to DC 12V 20A 250W. It also has the short-circuit protection, over-

voltage protection: 115% to 135%. 

  

  

Figure 3.8: 12 V 20 A Power Supply 

  

  

  

3.3.8       SG92R Servo Motor 

  

SG92R servo motor is a new version of the SG90 servo motor. The gears set of this 

servo motor is made by the carbon fibre which is more durable compare to the nylon 

gears set. This servo motor been used as the z-axis to move the pen position up and 

down. 

  

  

Figure 3.9: SG92R Servo Motor 
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3.3.9 Limit Switch 

 

 

Figure 3.10: Limit Switch 

 

 

The limit switch is switch that use to limit the travel object in a mechanism to past 

some predetermined point. In this project, the limit switches were used in the homing 

system of the machine. 

 

 

 

3.4       Setup of Arduino IDE Software 

  

The Arduino IDE software is open source which allow user to download the software 

through the IDE official website. The setup of Arduino Uno is simple. Once finish 

download and installed in the computer, the Arduino Uno microcontroller can be 

connected using the USB cable to power it. 

  

  

Figure 3.11: Arduino IDE Software 
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One external library file, grbl required add on the Arduino IDE software 

before uploading the code to the microcontroller. The grbl library file contains the 

coding to functions the CNC machine which is open source file that be able to 

download from GitHub website. After done downloading, this file must be added in 

“This PC > Documents > Arduino > libraries”. 

  

  

Figure 3.12: grbl Library File Location 

  

  

This source file is development by Sungeun and Simen (2015) researchers. 

After added the source file, Arduino IDE software was restarted. The grbl source file 

been load from contribute library in the Arduino IDE at “Sketch > Include Library > 

grbl”. The code been uploaded to the microcontroller once the code done compiling.  

 

 

 

3.5       Setup of Inkscape Software 

  

Inkscape software is free software that allow user to draw some project without any 

charge of license fee for using the software. In this project, Inkscape has been used to 

convert some simple drawing from this software and the exported image into a 

Gcode file format.  

  

  

Figure 3.13: Inkscape Software Version 0.48.0  
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Inkscape software with version 0.48.5 below was choose to download as the  

MakerBot Unicorn Gcode Extension only support for version 0.48.5 or below. The 

MakerBot Unicorn Gcode Extension file can be downloaded from GitHub website. 

In order to export image into Gcode format, a MakerBot Unicorn Gcode Extension 

file need to add to the Inkscape software. Once finish downloaded the file, the file 

extension need to be unpacked and the 4 file below: _init_.py, context.py, entities.py, 

svg_parser.py need to copy to the following directory Program Files > Inkscape > 

share > extensions and restart the Inkscape.   

  

  

Figure 3.14: MakerBot Unicorn Gcode Extension File 

 

 

  

3.5.1    Document Properties Setting 

  

Before import an image folder, document properties window was opened to 

adjust the page size by clicking on the File > Document Properties. The Default units 

and the units in the Document Properties window have been set to mm. The page 

side has been changed to 100 mm × 100 mm which is smaller than the workspace of 

CNC machine build 200 mm × 150 mm. 

  

  

Figure 3.15: Document Properties Window Setting 
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This software allow user to create own drawing image and able user to 

imports original images. For this FYP, both type of image: drawing image and 

original import images have been exported to gcode file for CNC machine drawing. 

  

  

  

3.5.2    Drawing Image 

  

The drawing image is an image that draws using the Inkscape software. Figure 3.16 

shows that the tools use for drawing. In this figure, a spiral shape image has been 

created. 

 

  

Figure 3.16: Spiral Shape Drawing Image 

  

  

  

3.5.3    Original Import Image 

  

The original image that download or import to the computer can be imported to the 

Inkscape software. Press on the File > Import or Ctrl + I to import the image. The 

image must be aligned on the square workplace as shown in the Figure 3.17. 
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Figure 3.17: Original Import Image 

  

 

 

3.5.4    Trace Bitmap of the Image 

  

In order to trace the image into Bitmap, Path > Trace Bitmap… or Shift + Alt + B 

have been pressed. The Brightness cut-off with threshold of 0.450 on the Trace 

Bitmap window was selected and then pressed on the “Update” button follow by the 

“Ok” button. Figure 3.19 showed the image after Bitmap trace. The original image 

with colour was deleted after done tracing.  

  

  

Figure 3.18: Trace Bitmap Setting  
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Figure 3.19: Bitmap Traced Image and Original Colour Image 

 

 

 

3.5.5    Export Image as Gcode Format 

  

Before export the image into Gcode format, the Bitmap trace image have been to 

path by going to Path > Stroke to Path or using Ctrl + Alt + C.  

  

  

Figure 3.20: Stroke to Path Image 

  

  

With the previous MakerBot Unicorn Gcode extension file added, the 

Inkscape can now export the image in gcode file format. Extensions > MI GRBL Z-

AXIS Servo Controller > MI GRBL Z-AXIS Servo Controller been selected. 
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Figure 3.21: Location of Gcode Export File 

 

  

Figure 3.22 below show the setting of the Gcode file setting. The Servo Up 

And down have been set to M3 and M5 respectively to represent the movement of 

the drawing pen on the Z-axis. The angle of the servo motor has been set to 50°. The 

speed of the X-axis and Y-axis must be same so that the drawing machine will be 

synchronised. The delay has been set to 1 second. 

  

  

Figure 3.22: Export Gcode File Setting 
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3.6       Universal Gcode Sender Software 

  

This Universal Gcode Sender software use for the CNC machine calibration purpose 

and also use for sending the Gcode file that created on the Inkscape to operating 

purpose for the CNC machine. 

 

  

Figure 3.23: Universal Gcode Sender Software 

 

 

 Table 3.1 shows the command for function of Universal Gcode Sender and 

Table 3.2 shows the command for the Grbl settings of CNC machine. The CNC 

machine settings can be modified through the commands under the Table 3.1 and 

Table 3.2. 

 

Table 3.1: Command for Function of Universal Gcode Sender 

Command Function 

$$ view Grbl settings 

$# view # parameters 

$G view parser state 

$I view build info 

$Nx view start-up block 

$C check gcode mode 

$X kill alarm lock 

$H run homing cycle 
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~ cycle start 

! feed hold 

? current status 

Ctrl-x reset Grbl 

  

  

Table 3.2: Grbl Settings of CNC Machine 

Command Function 

$0 step pulse, µsec 

$1 step idle delay, msec 

$2 step port invert mask 

$3 dir port invert mask 

$4 step enable invert, bool 

$5 limit pins invert, bool 

$6 probe pin invert, bool 

$10 status report mask 

$11 junction deviation, mm 

$12 arc tolerance, mm 

$13 report inches, bool 

$20 soft limits, bool 

$21 hard limits, bool 

$22 homing cycle, bool 

$23 homing direction invert mask 

$24 homing feed, mm / min 

$25 homing seek, mm / min 

$26 homing de-bounce, msec 

$27 homing pull-off, mm 

$100 x, step / mm 

$101 y, step / mm 

$102 z, step / mm 

$110 x max rate, mm / min 

$111 y max rate, mm / min 

$112 z max rate, mm / min 
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$120 x acceleration, mm / sec^2 

$121 y acceleration, mm / sec^2 

$122 z acceleration, mm / sec^2 

$130 x max travel, mm 

$131 y max travel, mm 

$132 z max travel, mm 

 

 

 

3.7 Setup of FreeCAD Software 

 

The FreeCAD software is a freeware that can use to create own 3D parametric 

modeller. The software was downloaded from the official website and installed on 

the computer. In this project, this software has been used to design some hardware 

components of the CNC machine.  

  

  

Figure 3.24: FreeCAD Software 

  

 

 

Figure 3.25: Sample Hardware Component Design using FreeCAD Software 
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 Figure 3.25 shows the sample of hardware components been design using the 

FreeCAD software. All the hardware design will be showed and discuss in chapter 4. 

The done design hardware was exported into stl file format. 

 

  

  

3.8      Setup of ideaMaker Software 

  

  

Figure 3.26: ideaMaker Software 

 

 

The ideaMaker is open software that created by the RAISE3D Technologies. The 

software is the GUI for the 3D Printer. The ideaMaker software can be the RAISE3D 

official website. The stl file that created from the FreeCAD software was import to 

the ideaMaker and it will export as a gcode file after done setting properties of the 

printing components.  

 

 

Figure 3.27: Print Preview of the Component 
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 This software was user friendly as it allows user preview the model of the 

printing hardware before export to gcode file. 

 

 

 

3.9 Hardware Build Stage 

  

After done purchase and print the hardware components, the hardware of CNC 

machine started to assembly. The aluminium body was first to build so that other 

components able to attach on the aluminium body frame. 

 

  

 Figure 3.28: Body Frame of the CNC Machine 

 

  

  

Figure 3.29: Arduino Uno + CNC Shield V3 + A4988 Stepper Motor Driver + 

Heat Sink 
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The CNC shield V3 was plug on the Arduino Uno board. The A4988 stepper 

motor driver attached with the heat sink and plug on the CNC shield V3 board as 

shown in Figure 3.29. 

 

 

Figure 3.30: Wiring of Stepper Motors, Power Supply, Limit Switches and 

Servo Motor on CNC Shield 

 

 

The 12 V 20 A power supply was connected to the blue socket of the CNC 

Shield. The X-axis stepper motor was connected to the left side motor driver while 

the Y-axis stepper motor was connected to the right side motor driver. The black 

wire must be at top of the connection to driver and the blue wire must be the last one 

connected to the driver. The red wire of the servo motor was connected to 5 V while 

the brown wire connected to ground. The orange wire of the servo was connected to 

the Z + axis. The common pin of both limit switch were connected to the white pins 

of X- and Y- on CNC shield while the normally open, NO pin of both limit switch 

were connected to the black pins of X- and Y- on CNC shield respectively.  
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Lead screw and the stepper motor were connected by using the connector. 

 

  

Figure 3.31: Connection of Stepper Motor and Lead Screw 

 

 

 

Figure 3.32: Voltage Checking on Power Supply 

 

 

 Once done construct the hardware of the CNC machine, the voltage of the 

power supply been checked before supply to the CNC shield to ensure that the power 

not oversupply on the motor. The voltage supply should be more than 12 V and less 

than 12.5 V. 
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3.10     Stepper Motor Calibration 

  

Calibration of machine is the next step after building the hardware. For CNC 

machine, the motors on X-axis and Y-axis must be calibrated. 5 mm been set as the 

tuning reference. 

 

 

Figure 3.33: X-axis Stepper Motor Result before and after Calibration 

 

 

 The initial step of the X-axis stepper motor is 250 steps / mm. When drawn, it 

shows the result of 50 mm instead of 5 mm. Thus, the steps / mm must be tune 10 

times smaller than the previous steps / mm. The formula for calculating shows below: 

 

Final steps per mm = (target length / actual length) × Initial steps per mm 

         = (5 mm / 50 mm) × 250 steps per mm 

         = 25 steps per mm 

 

 

Figure 3.34: Y-axis Stepper Motor Result before and after Calibration 
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The initial step of the Y-axis stepper motor is 250 steps / mm. When drawn, it 

shows the result of 50 mm instead of 5 mm which is same with the X-axis. Thus, the 

steps / mm must be tune 10 times smaller than the previous steps / mm. The formula 

for calculating shows below: 

 

 Final steps per mm = (target length / actual length) × Initial steps per mm 

         = (5 mm / 50 mm) × 250 steps per mm 

         = 25 steps per mm 

 

 

 

3.11     Operation Process 

  

Block Diagram of the complete operation: 

 

 

Figure 3.35: Operation Process of the CNC Drawing Machine 
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3.12     Equipment and Cost Analysis 

  

Table 3.3: Cost Analysis for each Components and Equipment 

No

. 

Component Quantity Price 

(RM) 

Remarks 

1 PLA 1.75mm Filament 1 44.00 From MYBOTIC 

2 Arduino Uno + cable 1 18.60 From Robotedu 

3 M4 stainless steel flat washer 21 2.10 From Robotedu 

4 M3 stainless steel flat washer 50 5.00 From Robotedu 

5 Allen key cap M4 screw 9 8.10 From Robotedu 

6 Allen key cap M3 screw 10 6.00 From Robotedu 

7 SG92R Servo Motor 1 8.00 From Robotedu 

8 2020 EU 20 T slot Rhombus 

Nut M4 T Nut 

30 21.00 From Robotedu 

9 12V 20A power supply 1 28.00 From Lazada 

10 M4 cap screw 50 5.00 From CNB Sdn. Bhd. 

11 M4 SS csk crew 50 6.00 From CNB Sdn. Bhd. 

12 M4 SS flat washer 50 1.50 From CNB Sdn. Bhd. 

13 M3 screw + hex nut 50 5.90 From Delta Fasterners 

(M) Sdn. Bhd. 

14 T-screw cube 2 20.52 From Taobao 

15 400mm long  8mm cylinder 

rod 

4 56.96 From Taobao 

16 Nema 17 stepper motor 2 84.92 From Taobao 

17 2020 model aluminium (1m) 4 35.58 From Taobao 

18 T-screw holder 2 4.24 From Taobao 

19 SK8 cylinder holder 8 12.00 From Taobao 

20 Wire protector 1 2.74 From Taobao 

21 Elastic coupling 2 7.76 From Taobao 

22 A4988 motor driver 2 19.31 From Taobao 

23 2020 model T-nut 40 12.40 From Taobao 

24 2020 model corner bracket 18 11.16 From Taobao 

25 T-screw 2 35.60 From Taobao 
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26 Linear bearing 8 15.52 From Taobao 

27 CNC shield V3 1 3.77 From Taobao 

28 Cable (10 meter) 1 12.00 Mr. DIY 

29 3-pins socket 1 5.00 Mr. DIY 

Total: RM 498.68 
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3.13     Project Milestone 

 

Gantt Chat for FYP 1: 

 

Table 3.4: Gantt Chart for FYP 1 

Activities  
1 2 3 4 5 6 7 8 9 10 11 12 13 14 

Research on 

background of 

project                             

Preparation and 

submission of 

proposal                             

Research on 

different type CNC 

machine                             

Reasearch on 

material to build 

project                             

Preparation for log 

report                             

Progress for report 

submission                             

Preparation for oral 

presentation                             

Oral presentation                             
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Gantt Chat for FYP 2: 

 

Table 3.5: Gantt Chart for FYP 2  

Activities 
1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 

Prepare material 

to build 

prototype                 

Install Software 

needed for the 

project                 

Calibrate the 

stepper motor                 

Design the part 

needed using 

FreeCAD                 

3D print out the 

part needed for 

the project                 

Build and test 

the prototype                 

Preparation for 

log report                 

Preparation for 

final oral 

presentation                 

Final oral 

presentation                 

Final 

Submission                

 

 

  

  

 



 

 

 

CHAPTER 4 

 

 

 

RESULTS AND DISCUSSIONS 

 

 

 

4.1 Results 

 

Before some product is complete, there must be some testing phase carry out that the 

functionality and also the quality of the product. In this section, some printed 

hardware components and limit switch homing system for the machine have been 

discussed. Several types of image have been drawn and discussed in this section. 

Two users been invited to test on the product quality.  

 

 

 

4.1.1 Printed Design Hardware Components 

 

The part of the hardware components like the stepper motor holder, linear bearing 

holder, pen holder, X-axis plane have been design by using the FreeCAD software 

and printed by the 3D printer. In this section, the design hardware components and 

the printed components were discussed. 
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4.1.1.1 Linear Bearing Holder 

 

Linear bearing holder was design for holding the linear bearing on both X-axis and 

Y-axis. For the X-axis, only two linear bearing holders were printed. Figure below 

shows the design of the X-axis linear bearing holder. The length of the X-axis linear 

bearing holder is longer compare to the Y-axis linear bearing holder as it designed to 

hold two linear bearings at the same time. 

 

 

Figure 4.1: X-axis Linear Bearing Holder Design 

 

 

 Time use to print single X-axis linear bearing is about 1 hour. Thus, the total 

time used to print two copy of this hardware components are 2 hours. 

 

 

Figure 4.2: Printed X-axis Linear Bearing Holder 
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 For the Y-axis linear bearing holder, it was designed for hold a linear bearing 

in Y-axis. Four Y-axis linear bearing holders were printed to hold the linear bearings 

on the Y-axis. 

  

 

Figure 4.3: Y-axis Linear Bearing Holder Design 

 

 

Around 45 minutes for printing single Y-axis linear bearing holder. The total 

time spent on printing the Y-axis linear bearing holders are 3 hours. Figure 4.4 shows 

the look of Y-axis linear bearing holder hardware component. 

 

 

Figure 4.4: Printed Y-axis Linear Bearing Holder 
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4.1.1.2 Stepper Motor Holder 

 

Stepper motor holder for X-axis and Y-axis were designed to hold the stepper motor 

so that the stepper motor can fix on the position.  

 

 

Figure 4.5: X-axis Stepper Motor Holder Design 

 

 

 For this component, addition two small bars were added on the design to 

create a base to support the printing part that not attached on the base. Time used to 

print out the X-axis stepper motor holder is 2 hours and 47 minutes. 

 

 

Figure 4.6: Printed X-axis Stepper Motor Holder 
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 The design of the Y-axis stepper motor holder is a little bit different compare 

with the X-axis stepper motor holder. The different of the holder is the position of 

the side design. 

 

 

Figure 4.7: Y-axis Stepper Motor Holder Design 

 

 

 

Figure 4.8: Printed Y-axis Stepper Motor Holder 

 

 

 From Figure 4.8, the side design of the Y-axis holder at middle of body while 

the X-axis holder side design at the end of the body. Time use to print the holder is 2 

hours 42 minutes. 
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4.1.1.3 X-axis Plane 

 

X-axis plan was designed as the plan body on X-axis which able to hold the servo 

motor and drawing components like pen or driller.  

 

 

Figure 4.9: X-axis Plane Design 

 

 

This X-axis plan was attached together with the X-axis linear bearing holders 

which allow the plane to move along in X-axis. 1 hour time was spent on printing the 

X-axis plane. 

 

 

Figure 4.10: Printed X-axis Plane 
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4.1.1.4 Pen Holder 

 

Pen holder was designed to hold the position of the pen on the X-axis. There were 

two design been created which is the upper pen holder and the lower pen holder. The 

upper pen holder was designed to hold the upper part of the pen while the other 

designed to hold the lower part of the pen and it can be adjust the screw to lock and 

unlock the pen according to size. 

 

 

Figure 4.11: Upper Pen Holder Design 

 

 

 

Figure 4.12: Lower Pen Holder Design 

 

 

 

Figure 4.13: Printed Pen Holder Left to Right (Upper Pen Holder, Lower Pen 

Holder) 

 

 

The time used to print the upper pen holder is 8 minutes while the lower pen 

holder is 11 minutes. 
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4.1.1.5 Holder Extension 

 

These components were designed to fix the cylinder rod holder and lead screw holder 

to same height level with the stepper motor. Two types of component been designed: 

cylinder rod holder extension and lead screw holder extension. 

 

 

Figure 4.14: Cylinder Rod Holder Extension Design 

 

 

 

Figure 4.15: Printed Cylinder Rod Holder Extension 

 

 

 Total eight copy of cylinder rod holder extension printed as each axis 

required four cylinder rod holder extension. The time spent on printing single copy is 

8 minutes and the total time spent to print all is 1hour and 5 minutes. 
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Figure 4.16: Lead Screw Holder Extension Design 

 

 

 

Figure 4.17: Printed Lead Screw Holder Extension 

 

 

 For the lead screw extension, each axis only required one copy. Time spend 

for printing single copy is around 10 minutes and the total time spent is around 20 

minutes. 
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4.1.2 Overall Look of the CNC Drawing Machine 

 

 

Figure 4.18: CNC Drawing Machine Hardware with Software 

 

 

The Figure 4.1 above shows the hardware and software of the CNC drawing machine. 

The pen used as the components to perform drawing on the hardware. 12 V 20 A 

power supply connected to the CNC shield to power up the stepper motor while the 

USB cable that connected to the Arduino Uno microcontroller board was used for 

power the Arduino Uno and sending the instruction to the Arduino Uno. 

 

 

 

4.1.3 Operation between the Hardware and Software of the CNC Machine 

 

The image that imported to the Inkscape software was traced into Bitmap image and 

exported as gcode file. After done export the gcode file, the Universal G-Code 

Sender software was opened. The software then required to connect to the hardware 

using baud rate with value of 115200. Once the hardware connected, the gcode file 

can be opened and sent to the hardware. The Arduino Uno microcontroller will 

enable the CNC shield and the CNC shield will sending instruction to the motor 

driver according to the commands in the gcode file. The stepper motor then will 

perform the drawing. 
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4.1.4 Homing System 

 

The homing system allows the CNC machine to locate to its origin point before start 

drawing. To use this function, the command $22 and $23 in Universal Gcode Sender 

software been set to 1 and 00000011 respectively. To call the homing function, a 

command “$H” was inserted in the command window of the Universal Gcode 

Sender software. Figure 4.19 show the working position of the CNC machine 

homing function being call. 

 

 

Figure 4.19: Random Position 

 

 

 

Figure 4.20: Homing Position 

 

 

 After done calling the homing function, both X-axis and Y-axis planes will 

move to the negative direction until the limit switches being triggered. The position 

that triggered the limit switches is the origin position of the machine. 



51 

4.1.5 Results of Drawing Image by CNC Machine 

 

Several types of image such as the import image, drawing image and image with 

word have been used to test on the CNC machine. 

 

 

 

4.1.5.1 Original Import Image 

 

Original image firstly imported to the Inkscape software and traced into Bitmap. 

Once done tracing the image, the image then been created a path for the image and 

exported as a gcode format file.  The gcode file then open using Universal G-Code 

Sender to perform drawing. Below is some image used to test draw. 

 

 

Figure 4.21: Original Import Image (Square) 

 

 

 

Figure 4.22: gcode File Image (Square) 
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Figure 4.23: Drawn Image (Square) 

 

 

 The side of the square image drawn is same as the given scale of gcode file 

square image. Table below shows the results in scale comparison. The accuracy of 

the simple image drawn in first and second times are 100% same as the original 

image. 

 

Table 4.1: Results of Image (Square) 

 Original 

Image 

Scale (mm) 

1
st
 Drawn 

Image 

Scale (mm) 

Accuracy 

(%) 

2
nd

 Drawn 

Image 

Scale (mm) 

Accuracy 

(%) 

X-axis 40 40 100 40 100 

Y-axis 40 40 100 40 100 

Time 

Complete 

Job (sec) 

- 32 - 32 100 

 

 

 After testing on the simple image on the CNC machine, an import image with 

curve line and much complicate has been tested. 
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Figure 4.24: Original Import Image (Dolphin) 

 

 

 

Figure 4.25: gcode File Image (Dolphin) 

 

 

 

Figure 4.26: Drawn Image (Dolphin) 

 

 

 The results obtained in the first and second time drawn images are exactly 

same as the original gcode image. With the results, it shows that the stepper motor in 

X-axis and Y-axis are fully synchronized. The time spent on drawing the dolphin 

image is 194 seconds. 
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Table 4.2: Results of Image (Dolphin) 

 Original 

Image 

Scale (mm) 

1
st
 Drawn 

Image 

Scale (mm) 

Accuracy 

(%) 

2
nd

 Drawn 

Image 

Scale (mm) 

Accuracy 

(%) 

X-axis 61 61 100 61 100 

Y-axis 32 32 100 32 100 

Time 

Complete 

Job (sec) 

- 194 - 194 100 

 

 

 

4.1.5.2 Drawing Input Image 

 

The imported images that done drawing on the CNC machine show excellent results. 

Below are the results testing on the drawn image using Inkscape software. The text 

input image and the shape input image in Inkscape software have been converted to 

gcode file and drawn by CNC machine. 

 

 

Figure 4.27: Text Input Image (EE) 
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Figure 4.28: gcode File Image (EE) 

 

 

 

Figure 4.29: Drawn Image (EE) 

 

 

 The scale of the first drawn image and the second drawn image are similar to 

each other. Both of the drawn images have the same scale compare to the original 

image. The time spent for completing the first and the second drawn image are the 

same. 

 

Table 4.3: Results of Image (EE) 

 Original 

Image 

Scale (mm) 

1
st
 Drawn 

Image 

Scale (mm) 

Accuracy 

(%) 

2
nd

 Drawn 

Image 

Scale (mm) 

Accuracy 

(%) 

X-axis 25 25 100 25 100 

Y-axis 17 17 100 17 100 

Time 

Complete 

Job (sec) 

- 72 - 72 100 
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Next is the spiral line image testing on the CNC machine. This image chooses 

to test on the synchronization of the stepper motor in both X-axis and Y-axis.  

 

 

Figure 4.30: Shape Input Image (Spiral) 

 

 

 

Figure 4.31: gcode File Image (Spiral) 

 

 

 

Figure 4.32: Drawn Image (Spiral) 

 

 

 From the spiral line image drawn by the CNC machine, it shows that the X-

axis and Y-axis stepper motor being synchronized well as the Figure 4.32 shows a 

smooth drawn spiral line.  
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Table 4.4: Results of Image (Spiral) 

 Original 

Image 

Scale (mm) 

1
st
 Drawn 

Image 

Scale (mm) 

Accuracy 

(%) 

2
nd

 Drawn 

Image 

Scale (mm) 

Accuracy 

(%) 

X-axis 49 49 100 49 100 

Y-axis 47 47 100 47 100 

Time 

Complete 

Job (sec) 

- 48 - 48 100 

 

 

 The results in Table 4.4 show that the first and the second drawn spiral image 

have the similar scale on X-axis and Y-axis. The time spent for completing the first 

drawn and the second drawn spiral line images are the same. 

 

 

 

4.1.6 Users Testing 

 

After done internal testing, two users have been invited for external testing purpose. 

Some reviews have received from the users to make some adjustment on the setting 

of the CNC machine. 

 

 

Figure 4.33: First User tests to use the CNC Machine 
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 The first user are invited to use the CNC machine with his own input 

drawing. The first user have write a nickname and saved as the image. The image 

then be transformed into the gcode format file for CNC drawing. 

 

 

Figure 4.34: Image create by First User (Robin) 

 

 

 

Figure 4.35: gcode File Image (Robin) 

 

 

 

Figure 4.36: Drawn Image (Robin) 
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 The nickname drawn image obtained look similar compare with the original 

drawing in the computer. The user gives a good review on the accuracy of the CNC 

machine. User also gives some comments on the drawing speed as the drawing speed 

is a bit slow. 

 

Table 4.5: Results of Image (Robin) 

 Original 

Image 

Scale (mm) 

1
st
 Drawn 

Image 

Scale (mm) 

Accuracy 

(%) 

2
nd

 Drawn 

Image 

Scale (mm) 

Accuracy 

(%) 

X-axis 73 73 100 73 100 

Y-axis 48 48 100 48 100 

Time 

Complete 

Job (sec) 

- 219 - 218 99.54 

  

 

From the results obtained, the time recorded for the first drawn image is 1 

second longer compare to the second drawn image. Both of the drawn images show 

exactly similar to its original image. 

 

 

Figure 4.37: Second User test to use of the CNC Machine 
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 Second user was being invited to test use of the CNC machine. The user was 

advised to create more complicate images to test on the machine. 

 

 

Figure 4.38: Image create by Second User (Terry + Star) 

 

 

 

Figure 4.39: gcode File Image (Terry + Star) 

 

 

 

Figure 4.40: Drawn Image (Terry + Star) 
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 Image that second user created consists of the shape drawing and word 

writing. The image created by the user been converted into the gcode file and run on 

the machine. Good review also been received from the second user as the images 

drawn by the user was able to draw out exactly same in scale compare with the 

original image.  

 

Table 4.6: Results of Image (Terry + Star) 

 Original 

Image 

Scale (mm) 

1
st
 Drawn 

Image 

Scale (mm) 

Accuracy 

(%) 

2
nd

 Drawn 

Image 

Scale (mm) 

Accuracy 

(%) 

X-axis 58 58 100 58 100 

Y-axis 38 38 100 38 100 

Time 

Complete 

Job (sec) 

- 181 - 181 100 

  

 

From the results obtained in Table 4.5, it shows that the scales for both drawn 

images are same as the original image. The time spent on two drawn images also 

same. 

 

 

 

4.2 Discussions 

 

In order to build a good quality product, a few times of checking on hardware and 

software cannot skip. Before obtain good results shown in the section 4.1. There are 

some challenge parts face in this project. This section will discuss on the problems 

faced in this project and the solutions that came out to overcome the problems. 
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4.2.1 Components Used to Build CNC Machine 

 

The selection of components and hardware used are time consuming. Coming out a 

draft design on the hardware and listing out all the components needed are important 

to keep the project on budget. For this project, some of the smaller components such 

as the X-axis and Y-axis linear holder, one part that cost around RM 10 and many of 

this part needed to build. Buying all this small components will lead to insufficient 

cost for buying more important part or hardware components. In order to overcome 

the problems, the smaller components have been designed using the FreeCAD 

software. After done all the design works, the designs were printed by using the 3D 

printer which available in university. One spool 1 kg PLA filament that cost around 

RM 44 was used as the material for 3D print the components. By using 3D printed 

hardware components, the cost for building the machine has successfully reduce by 

50 % compare to directly buy the components. Some of the hardware components 

like the 2020 model aluminium, cylinder rod were bought directly from China after 

done some survey on the market price of the product between Malaysia and China. 

This will help to cut-down the cost use to build the whole CNC machine. 

 

 

 

4.2.2 Accuracy of Stepper Motor in X-axis and Y-axis 

 

The accuracy is the most challenging part of this project. The settings of the stepper 

motor in X-axis and Y-axis must be same so the CNC machine will be synchronized. 

The problem face by this project is both X-axis and Y-axis motor cannot synchronize 

after both X-axis and Y-axis done the same setting. To overcome this problem, some 

further checking such as checking on stepper motor speed setting and the hardware 

checking have been conducted. Before checking on the software setting part, 

hardware is considering to look over first. The connection of the hardware must be 

correct in order to generated correct output. After done checking the hardware 

connection, the setting of the stepper motor for X-axis and Y-axis needed to retune 

and calibrate until both X-axis and Y-axis stepper motors been synchronized. The 

settings of the maximum rate of the stepper motor in mm / min and the acceleration 

of the stepper motor in mm / s
2
. The optimize settings for maximum rate and 
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acceleration of the stepper motor in X-axis and Y-axis are 250 mm / min and 10 mm 

/ s
2
. With this setting the drawn image obtained from the CNC machine is same as 

the original image. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

 

CHAPTER 5 

  

  

  

CONCLUSION AND RECOMMENDATIONS 

  

  

  

5.1 Conclusion 

  

In conclusion, the objectives of this project have been achieved. An Arduino based 

CNC drawing machine which able to move along x-axis and y-axis was built. The 

cost for building the CNC drawing machine is lower compare to the industries which 

able apply on small businesses and family use as the cost is affordable by family and 

small businesses. The CNC drawing machine built was successfully communicated 

with the software to carry out given task. The gcode file image that created from the 

Inkscape software was successfully transferred to CNC machine for drawing. The 

import images and the input images were successfully convert to the gcode file and 

been drawn by the CNC machine. The drawn images scale is exactly same with its 

original import images and input images. Two users have been invited to use the 

CNC machine. Both users were satisfied with the results drawn by the CNC drawing 

machine. The drawing speed of the CNC machine has been increase according to the 

user feedback. Extra feature like the homing system had successfully added on this 

project.  Some of the hardware components have been designed and printed using 3D 

printer to cut down the building cost of CNC machine. 
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 5.2 Future Work and Enhancement 

  

Some recommendations on future enhancement of this project are listed below. The 

recommended enhancements can be implemented for project extension in future. 

  

  

  

5.2.1 Three Dimension Printing 

  

The concept use for the 3D printing is same as the CNC drawing machine. Extra axis 

need to be added on the CNC drawing machine to perform 3D printing. With 

additional axis added, a CNC machine can carry out different function task.  

 

 

 

5.2.2 Software Development 

  

As the functionalities of single CNC machine increase, extra software will be 

required to install so that the CNC machine can carry out the tasks. For example, to 

use the CNC machine 3D printing function, 3D printing software is required. 

However, user may fail to use the correct software to carry out the given tasks and 

this will not be user friendly to the user. GUI software has to create for the CNC 

machine and include all functionality of the CNC machine. Software that includes all 

functionality of the CNC machine will be simpler to handle and operate by user. A 

user friendly software and hardware will make the product look more attractive to the 

user. 
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APPENDIX A: CNC Shield V3 Schematic Diagram 
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APPENDIX B: CNC Shield V3 Layout 
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APPENDIX C: Dimension for 2020 Aluminium Steel 
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APPENDIX D: Nema 17 Stepper Motor Datasheet 
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APPENDIX E: Servo Motor SG92R Datasheet 
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